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Screen Layout

This section of the manual is intended to overview the components of G-ZERO Conversational CAM
System for Lathes main screen.  Detailed information on specific features is covered in later sections.

Title bar
The title bar extends across the top of the application window, and displays the name of the program as well
as the name and path of the current source file.  The three buttons located at the right end of the title bar
allow you to  minimize,  maximize (or  restore), and  close the window.  Closing the window
will exit G-ZERO.
Place cursor on title bar and:

double-click the left mouse button to maximize or restore the window
click (left mouse button) and drag mouse to relocate the window (windows should not be maximized)
right-click (click right mouse button) to display right mouse list box with these commands: Restore,
Move, Size, Minimize, Maximize, and Close (Alt+F4)

Programming / Editing area
This is the largest section of the G-ZERO application window and displays the contents of your current
source file.  (Note that you need to Save your file before the displayed source code is actually recorded in
your source file).
When the information on the programming area needs a larger display area, a vertical and/or horizontal
scroll bar(s) will appear at the side and/or bottom of this section.  Use your mouse to click the scroll arrows
(at the end of the scroll bars) or click and drag the scroll box to move around the programming area and
display the overflowed sections.  Only one source file can be opened at a time.
The background color of the programming area as well as the font style and size can be adjusted in the
Tools | Options | View window.
The Programming area is also the place where source code editing is done.

Title bar (with file name and location)

Menu bar (pull-down menus)

Commands menu

Dialog bar

Status bar (with suggested speeds)

Programming / Editing area

Code building area

Viewport
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Menu bar
G-ZERO menu bar contains the following pull-down menus:

Use mouse to select an option from the menu bar.  When the menu drops down, click on the command you
want.
You can also use keyboard to make your selections.  Press and hold the Alt key and key in the character that
is underlined (e.g.: Alt+F+S for File | Save).  Once the menu has dropped down, you can also use the
keyboard arrow keys to make your selections and press the Enter key when your choice is highlighted.
A shortcut is available for commands most frequently used.  Function keys or shortcuts are listed on the
drop down menus.

Commands menu
G-ZERO Lathe currently has 39 programming commands (#18 and #38 are not available) and they are
listed on the left side of the application window.  Use the scroll bars to display the rest of the commands.
To call (or use) a command, place your mouse cursor on top of the command icon or description you want,
and click the left mouse button.  You can also use the keyboard numbers (or 10-key pad) to call a command
by typing the number that correspond to the command you want (shown before the name of the command).
Example: keying in  has the same effect as using the mouse to click on the POINT command.
G-ZERO Lathe normally displays the full command menu (icons and name); however, you have the option
of displaying just the icons or no commands at all.  The advantage of reducing the visibility of the com-
mands menu is that it frees monitor space to increase the programming area.  To adjust the size of the
commands menu, place your mouse cursor on the right side of the commands scrolling bar until the cursor
changes to a double arrow ; at this point, hold and drag it to the left or right to respectively reduce or
increase the display of the commands menu.  You can also, select (or unselect) Full menus from Tools |
Options | Views.
G-ZERO disables (shows in gray) the commands that are not logically needed.  The beauty of this feature is
that it can guide new G-ZERO programmers in the proper sequence for programming.
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Code building area
Each source code line is built in this area.  Each time a programming command is called, a new line number
and command name will appear on this bar.  Commands parameters are also sequentially  displayed here as
the command is being formed.  Once the entire command line is created, the source line will be transferred
to the programming area.
Example of complete command line: 8  POINT  x3 z-1.5

Dialog bar
This is the section G-ZERO uses to display the questions that will assist you to create a source line.
Example:   When you first start a program, the dialog bar displays:

Please select the option you would like and then press ENTER.

When the POINT command is called, G-ZERO will immediately ask you the first question and waits for
your answer to the first parameter value:

WHERE, IN X WOULD YOU LIKE TO POSITION THE TOOL?  3

You will notice that a default value is suggested by the program.  This value is the last number entered to
answer that specific question.  If you accept that number, press the ENTER key.  If you need another
number, just key in your new value.
After you enter the answer to the first question, the second question is displayed in the dialog bar:

WHERE, IN Z?  -1.5

Again, the default value is displayed and G-ZERO waits for your reply.
After you press the Enter key to the the last answer, G-ZERO transfers the entire source line from the code
building area to the programming area.  G-ZERO will now wait for your next instruction:

Please select the option you would like and then press ENTER.

Status bar
The status bar extends across the bottom of the G-ZERO application window.  This is the area where you
can find:
4.781, -2.041 . mouse cursor coordinates (only when mouse cursor is within the viewport display)
1:52PM ........ current time (taken from computer clock)
Note for Lathe v3.x users:  Suggested SFM and RPM are now displayed on pop-up boxes.

Viewport
G-ZERO uses the viewport to display the graphical representation of the current source file in various
formats (e.g.: solid view, wireframe, wireframe with tool path, etc.)
The viewport can also help you verify or debug a source program.  Use your mouse to click on any section
of the graphic displayed on it, and G-ZERO will find and highlight its corresponding source code in the
programming area.
This viewport window can be resized and placed at any location on your computer screen, even attach it to
the G-ZERO application window.
(See the Viewport section of this manual for more details.)

line number
command
2 parameters



8      REFERENCE Basics

Dialog Boxes (from Tools | Options)
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Preferences

Command Menu
You have the option of displaying full menus (icons and descriptions), or just icons.  To switch from one
option to the other, select (or unselect) the Full Menus check box in Tools | Options | View window.

Color and Font
You can customize the background color as well as the text font and size of your programming codes.  To
do this, make the desired changes in the Background Color and Fonts section in the Tools | Options | View
window.

G-code Text Editor
G-ZERO uses the assigned Text Editor to open the G-code file right after it is created through the

 20) POST command (F12).

Setup the G-code text editor you like in the Tools | Options | File Locations window.  The default editor is
Windows Notepad.

Metric / Inch System
To program in Inches (output in inches):

Metric check box (Tools | Options | General) needs to be unselected.
Ctrl+M (input a millimeter value and let G-ZERO convert it to inches).
Example:  key in 1 (mm) followed by Ctrl+M to have that number converted to 0.03937 (in)
Ctrl+Shift+M (input an inch value and let G-ZERO convert it to millimeter).
Example:  key in 1 (in) followed by Ctrl+Shift+M to have that number converted to 25.4 (mm).

To program in Millimeters (output in millimeters):
Metric check box (Tools | Options | General) needs to be selected.
Ctrl+M (input an inch value and let G-ZERO convert it to millimeters).
Example:  key in 1 (in) followed by Ctrl+M to have that number converted to 25.4 (mm).
Ctrl+Shift+M (input a millimeter value and let G-ZERO convert it to inches).
Example:  key in 1 (mm) followed by Ctrl+Shift+M to have that number converted to 0.03937 (in).
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File Management

Open
Start a new source file by typing a new filename in the Source File to Open window
(File | Open).  Since the file does not exists, G-ZERO will start a new source file.
Open an existing source file by selecting it from the Source File to Open window
(File | Open).  Make sure that the lower section of this window (file type) is set to
display G-ZERO Lathe source files (extensions .l)
Open an existing G-code file by selecting it from the Source File to Open window
(File | Open).  Make sure that the lower section of this window (file type) is set to
display G-code files (extensions .t).  G-code files are opened with the default text
editor.  To change the default text editor, go to Tools | Options | File Locations windows
and use the Browse button to setup the link to the new text editor.

Incremental search - WinLauncher
Launching files through WinLauncher allows you to use
the incremental search method: type the first letter(s) of
your filename to narrow down your search by displaying
only the filenames that meet your search requirements.
If you have taken a snapshot (see Viewport section) of your
files, these pictures can help you search for the file you
want to work on.

Save
Save your current source file by clicking the Save option from the File pull-down menu (File | Save).  By
default, G-ZERO automatically saves every three minutes.  (This can be adjusted on the Save screen from
Tools | Options menu.)

Save As
Save As creates a new file with the current information (duplicates the current file).  If the current file has
changes that were not saved, G-ZERO will prompt you to save the changes before closing the current file
and starting the new file.  Enter a new file name (you can change the drive/directory if you want).
The new file is going to become the new current file.  (Check the new file name and/or location displayed
on the upper left corner of your G-ZERO main window)

Backup
Backup the current file into a floppy disk by selecting the Backup option from the File pull-down menu
(File | Backup).  A backup file is an exact copy of the current file.  The current file remains active.
To change the default backup disk drive (A:), make the appropriate selection in the Save screen from
Tools | Options.
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Export Macro
Create a macro file with a portion of the current source file by
selecting the Export Macro option from the File pull-down menu
(File | Export Macro).
After typing a new file name (for the macro file) in the Save As
window, a new window pops up to allow you enter the sequence
of source lines you want included in the new macro file.
Macro files are text files with default file extensions .U.  They
can be imported into a source file with the # commands.

Delete
Delete the current source file by selecting the Delete option from the File pull-down menu (File | Delete).

Close
Close the current source file by selecting the Close option from the File pull-down menu (File | Close).  You
can also click on the X button in the upper right corner of the application window (Title bar).

Print
Print entire source file
File Menu.  Send the current file directly to the default printer by selecting the Print Source option from the
File | Print pull-down menu (File | Print | Print Source).
21) Print.  Use the 21) Print command and print from line 1 thru last line of source program.

Print selected source lines
21) Print.  To print only a section of your source code, use the PRINT command.  G-ZERO will ask you to
enter the first and last line numbers of the source codes you want to print.

Print toolsheet
File Menu.  Print the tool list (all source lines with the TOOL command) by selecting the Print Tool List
option from the File | Print pull-down menu (File | Print | Print ToolList).
21) Print.  Call the 21) Print command and print from line -1 to line 0.

NOTE:  To change the default printer, select Start | Settings | Printers from Windows taskbar (usually at the
bottom of your screen), and select the Set As Default options in the right-click list of the printer you want to
set as default.
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Programming

Source Programming
G-ZERO is a Source Based Programming software that thinks the way a machinist thinks.  You type in
commands using exactly the same logic your CNC uses.

Programming sequence
First, start with the Material command (Mat’l).  G-ZERO asks you several questions to guide you in

providing the dimensions and type of material you are going to use.  It’s conversational!
Second, program the Tool command to indicate tool number and whether it’s going to be an ID or OD

cutting.  After answering these questions, G-ZERO automatically calls the Type command to get
detail information about the tool you are using such as tool type, material, tool nose radius, and
size.

Third program a cutting operation such as facing (Face, FGroove), grooving (Groove), threading
(Thread), turning (Point, Radius, Line), or milling (Mill).  Once again, just answer the questions
G-ZERO has for you about your cutting operation.

Repeat lines
Click source line number to instantly call the REPEAT command from that line.
Example: - Click on line number 22

- G-ZERO calls the command REPEAT:
REPEAT  from22 thru

- Click on line number 27
- G-ZERO completes programming the command:

REPEAT  from22 thru27

Collapse/Expand lines
Ctrl+LeftArrow.  Collapses source program hiding all lines except for the Material and Tools commands.
Line numbers will be preceded by a double arrow symbol ».  Note:  If source lines from some Tools were
previously made visible, they are not going to be collapsed.
Ctrl+RightArrow.  Expands the entire source program to its fully visible condition.
Click on double arrow ».  While in collapsed condition, use your mouse to click on a double arrow » to
display all lines from that Tool.  Visible lines (while in collapsed condition) are shown with a dot · in front
of their line numbers.  Press any Redraw function key (F2, F3, or F6) to view a graphical representation of
only source lines shown.
Click on dot ·.  While in collapsed condition, use your mouse to click on any dot symbol · to collapse that
Tool back down again and hide its source lines.
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Source Editing
Change a value
To change a value in a source program, use your mouse to click the value you
want to change, type in a new value to replace the one that is highlighted.
The background of the editing area turns to blue when you are in editing
mode; press the Enter key to save your changes and exit editing mode.  Press
Escape to leave it unchanged.
Note:  To edit a comment, just click on the comment to access the editing
mode.  Use Backspace and Arrow keys to assist your editing.  Press the
Enter key when done, or Escape to abandon editing.

Change sign
To change the sign of a value, use your mouse to click (left mouse button) the value to which you want to
change the sign, right-click (right mouse button) the just highlighted value to change its value from positive
(+) to negative (-), or negative to positive.  Press the Enter key to exit editing mode.

POINT to RADIUS type2
Press and hold the Alt key and use your mouse to click on a POINT command to convert it to a RADIUS
type 2 (corner).  This is a nice help to clean up CAD data.

RADIUS type2 to POINT
Press and hold the Alt key and use your mouse to click on a RADIUS type 2 command to convert it to a
sharp POINT.

LINE (unknown angle  known angle)
Press and hold the Alt key and use your mouse to click on a LINE command with unknown angle to
convert it to a LINE command with known angle.

RADIUS (type0 unknown radius  type1 known center)
Press and hold the Alt key and use your mouse to click on a RADIUS type 0 command (unknown radius)
to convert it to a RADIUS type 1 command (known center).  Note that there is no “undo” for this proce-
dure, but you can always manually change type “1” to type “0” (the x and y values in parenthesis will be
ignored by G-ZERO for all RADIUS type0)

Search source line using Viewport
Click on any wireframe or solid parts in the viewport and G-ZERO will highlight the related command line
in the source program.  If you see that the viewport shows a graphic that doesn’t seem correct, click on the
questionable element to locate the line code that needs to be changed.

Purge file
Most “deleted” lines in G-ZERO are actually just hidden, and not permanently deleted.  The Purge option
(from the Edit pull-down menu) permanently removes all such lines from the source program.  After a file is
purged, all line numbers will be automatically re-sequenced.

Find - Find Next
Find.  Use Ctrl+F or Edit | Find to locate the first value (or strings of values/characters) within your active
source code.
Find Next.  Use Ctrl+S or Edit | Find Next to locate the next appearance of the value (or strings or values/
characters) previously searched using Edit | Find.
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G-code
After programming your source, G-ZERO can regenerate your entire part program in precisely the language
your CNC understands.  Rapid Output customizes your post processors so your time is spent making good
parts, not editing tedious G-code.

Generate G-code
You only need two simple steps to generate G-code:

F12.  Press F12 (or Tools | Post Process, or 20) Post) to open the Tool Post Selection window.  (Note
that post processors are customized and sold separately)
Select Post.  Select a tool post (for example: MAZAK) and watch how G-ZERO creates the right G-
code for the machine selected.  Posts (.p files) are usually saved in the Lathe\Dat directory.  However, if
you have them stored in a different directory, used the Look in: section of the Tool Post Selection
window to locate your posts.

G-ZERO saves the G-code file (extension .t) just generated and displays it on your screen using Notepad (or
your default G-code Text Editor)
To change your default G-code Text Editor, click on the Tools | Options menu, and select the “File Loca-
tion” dialog box.  On the “Text Editor” section, assign the program you would like to use as the default text
editor.

Open G-code file
Select File | Open from the G-ZERO application window.  In the “Source File to Open” window, make sure
to display “G-code (*.T*)” type of file in the “Files of type” option at the bottom of the window.
Cancel the “Sent to CNC...” window if you don’t want to send it now;  G-code will be opened with the
default text editor (e.g.: Windows Notepad)

Post Processor Perfection
If you ever need to edit your G-code, DON’T DO IT!  What you need is to update your post processor, and
we can do it for you when you send us:

1. Print out of the incorrect G-code with clear instructions (e.g.: cross out codes you don’t need, or write
down those you need to add)

2. Source program (.m file) that generated the incorrect G-code and post (.p file)
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Pop-Up Boxes

Pop-up boxes add extra information to your computer screen to assist you answering G-ZERO prompts.
For example:  the 6th question for the command 17) MAT’L asks “What is the part made of?”  This
question appears along with a pop-up box that lists the numbers to key in that correspond to specific types
of materials.
Information from pop-up boxes are stored in text files in the LATHE\WINDAT directory.  Some default
pop-up boxes are:
File name Command Question # Contents

17.6 17) MAT’L 6 Type of materials  (e.g.: 4=ALUMINUM)
36.1 36) TYPE 1 Type of tools  (e.g.: 1=80-degree-diamond)
36.2 36) TYPE 2 Tool material  (e.g.: 1=TIN)
36.4 36) TYPE 4 Tool size  (e.g.:  0.375)
8.6 8) FACE 6 Finish chart
9.7 9) ROUGH 7 Feed comparison chart

Edit Pop-up Boxes
If the standard pop-up boxes do not contain exactly what you need, the information can be changed.  To edit
the information in a pop-up box, use a text editor such as Windows Notepad.
Example 1:  You want to modify the pop-up box that appears when you are answering the 4th question from
command 36) TYPE.  Use Windows Notepad to open the file C:\LATHE\WINDAT\36.4 and make your
changes.  Note:  if you are using a word processing, make sure you always save the files as TEXT ONLY.
Example 2:  You want to delete the pop-up box that appears when answering the 5th question of command
11) THREAD.  Delete the file 11.5 located in C:\LATHE\WINDAT.

Create Pop-up Boxes
To create a new pop-up box, you first need to know the command number and order of question in which
you want the pop-up box to appear.  This file needs to be a text file located in the C:\LATHE\WINDAT
directory (assuming your Lathe program is in your C: drive).  The file name is formed by two numbers
separated by a period.  The first number corresponds to the command number, and the second number
represents the sequence of the question.
Example:  You want to create a “reminder” to pop-up when you are answering the first question of com-
mand 15) REPEAT.  Using Windows Notepad:

1. Start Notepad:    Start | Programs | Accessories | Notepad
2. Type your message within Notepad.   Example:

To reverse the direction your cutter takes
along a surface, use repeat backwards.
Example:    FROM 14 THRU 10

3. Save your file using the appropriate name and location:
File | Save As
C:\LATHE\WINDAT\15.1
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Tool Library

The Tool Library is a set of files located in the LATHE\WINDAT subdirectory.  Their file names always
start with either IDTOOL or ODTOOL followed by a number (Tool Type #), and the file extension is always
.F.  Example:  IDTOOL2.F
Tool library is maintained by the FEEDS.EXE file.  Each .F has five sections to store the details of one tool:

1. Macro to draw tool holder picture
2. Macro to draw tool picture
3. Tool geometry
4. Reduce feed rate (%)
5. Feed rate control (IPR)

FEEDS.EXE
Create a New .F File

1. At the DOS prompt, in the LATHE directory (Example: C:\LATHE>), type FEEDS to start the Feeds
program.

2. The Feeds program will ask “What speed file would you like?”  Type the name of the NEW file you
want to create (Example: IDTOOL22.F)

3. The Feeds program will ask “What working .F file most closely resembles this new one?”
4. Use the arrow keys or the mouse to pick a file from the list shown.
5. The Feeds program will copy the information of the existing file into your new file.  Now, you are

ready to modify the new file to accomodate the information for your new tool.  (See steps 4-5 below)

Modify an Existing .F File
1. At the DOS prompt (Example: C:\LATHE>), type FEEDS to start the Feeds program.
2. The Feeds program will ask “What speed file would you like?”  Use the arrow keys or the mouse to

pick the file you want to modify.
3. Use the arrow keys or the mouse to pick the file you want to modify.
4. Your cursor is the little green box.  (When the cursor is at the end of a line, it contains a left arrow)

When your cursor is inside a chart or box, anything typed will typeover the current character.
5. When done, press the  key.  If you made any changes, the program will ask if you want to Save the

changes.  Type Y for Yes and
N for No.

<Enter> Moves cursor to
beginning of next line.

<Insert> Inserts a new line at
cursor.  Use this to
add a new line to a
Macro, or to the
FEED & SPEED
chart.

<F9> Deletes line of
characters at the
cursor.  (Do not delete
the chart or lines
separating columns in
the charts).

<Tab> When filling in or modifying the 3 bottom charts, <Tab> will move your cursor to the next
value automatically.

<Backspace> Deletes a character to the left of the cursor.
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Tool Picture
Every .F file starts with two macros that have the details needed to dipslay the shape of the tool when the
TOOL command is programmed and when the  is pressed (Redraw with tool).
Note:  For details on Macros, see the Macro section of this manual.

Macro to Draw Tool Holder Picture
Here is an example:

37,0
0,COLOR 3
0,DEFAULT TNR=.08 SIZE=1
16,0,-#1-#1,#1
1,0,0
1,-.0875*#2*1.2*2,#2*1.2
1,-.0875*#2*1.2*2,#2*8
1,-#2*1.2*2,#2*8
1,-#2*1.2*2,.0875*#2*1.2
1,0,0
37,0
0,COLOR 9
1,-.0875*#2*1.2*2,#2*1.2
1,-#2*1.2*2,#2*1.2
16,0,0,0

Macro to Draw Tool Insert Picture
Here is an example:

37,0
0,COLOR 10
0,DEFAULT TNR=.031 SIZE=1
16,-85,-#1-#1,#1
4,135,1
2,#1,1,0,0
2,#1,1,-#1+#2+#2,.14*#2
2,#1,1,-#1+#2+#2,1.07*#2
2,#1,1,0,.93*#2
2,#1,1,0,0
5,135
16,0,0,0

Program a 37) Mill every time you want to stop
drawing a line and begin a new line in your picture
of a TOOL/ INSERT or HOLDER.

Specify the color
of the HOLDER
or INSERTusing
the macro
comment
COLOR.

0 Black
1 Blue
2 Green
3 Cyan
4 Red
5 Magenta
6 Brown
7 White

8 Gray
9 Light Blue
10 Light Green
11 Light Cyan
12 Light Red
13 Light Magenta
14 Yellow
15 Hi-intensity White

Variables used for correctly scale the
size of the tool: TNR, SIZE.
Variables to shift (translate) the
drawing of the tool to its correct
position in the Tool Library display:
XOFFSET, ZOFFSET.

16) ROTATE
command adds
a tool clearance
angle.

Clearance Angle

Tool nose 
radius

Tool Set Point

Use 4)COMP and 5)UNCOMP to describe the
geometry.
For INSERTS, be sure to unRotate with 16,0,0,0.
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TOOL GEOMETRY
Fill in the full angle and the clearance angle of your insert.
These values should match the geometry programmed in the Tool Holder Picture Macro
and the Tool Insert Picture Macro above this chart.

REDUCE FEEDRATE (%)
CUT DIR
With some cutting tools, you may wish to slow down when
cutting in certain directions (CUT DIR).  Normally the tool will
feed at 100%.

• If you would like the tool to slow down 25% (75% of
normal) when cutting away from or towards the chuck, then enter 75% in the box just below the left/
right arrows.

• If you would like the tool to slow down 25% (75% of normal) when cutting upward, then enter 75% in
the box just below the up arrow.

• If you would like the tool to slow down 25% (75% of normal) when cutting downward, then enter 75%
in the box just below the down arrow.

SMALL RADS
With finish tools, you may wish to slow down cutting around small outside arcs.
If you make very small parts and you would like all arcs smaller than .003 to be cut at 30% of normal, then
change the first R< to R<.003.  Next, move down to the box just below R<.003 and enter 30%.
Remember that the small R's values must go from smaller (left) to bigger (right).

Example: R<.003 R<.033 R<.016
Wrong!  Small to big to smaller.
R<.003 R<.016 R<.033
OK - Small to big to bigger.

FEEDRATE CONTROL (IPR)
This chart controls all feeds and speeds for this cutter type.

PART MATERIAL (e.g..: 316)
Using 8 or less letters or numbers, enter the name or abbreviated name of a PART
MATERIAL (or Work Material).  It will exactly match one of the names in PART
MATERIAL LIST (pop-up box 17.6)

TOOL MATERIAL (e.g.: ALUM/OXY)
Using 8 or less letters or numbers, enter the name or abbreviated name of a TOOL
MATERIAL.  If this tool is available in a range of materials, type just one TOOL
MATERIAL here.  (The next TOOL MATERIAL for this same PART MATERIAL
goes on the next line down directly below this value.

SIZE/WIDTH
Type in the size of this tool: insert: inscribed circle

grooving tool: width
drill or mill: diameter

If this tool is available in many sizes, enter the sizes in ascending order, one size per line.  Type the next
largest size directly below this answer.
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DOC/ROUGH (DEPTH)
If this tool is never used for ROUGHing, skip this (leave this column blank).
If this tool is used for ROUGHing,you may type in several depth of cut values (DOC) that correspond to
different SFM (surface feet/minute) values.
Type in the smallest DOC value (for this insert) now.  Type in the next DOC value directly below.  The next
DOC value goes below this value etc.

PEED CONTROL (SFM)
Type in the surface feet/minute for this tool keeping in mind:  TOOL MATERIAL, PART MATERIAL and
SIZE (and DOC if a roughing insert).  If you don't know the SFM, ask your tooling salesman for a recom-
mended value.

NORMAL CUTTING
If this tool is never used for ROUGHing, GROOVing or MILLing, skip this.
These four columns are feedrates for different load levels ranging from f1 (lightest) to f4 (heaviest).  Type
in the feedrate for each load.  HINT:  The lighter the load, the smaller (slower) the feedrate.

LIVE MILL PLUNGE
Use this when milling with Live Tool Option only.  If you don't have live tooling, skip this.

Entering Feeds & Speeds
If this is a ROUGHing tool and you want to enter another DOC for this same tool, move your cursor to the
next line down and fill in these columns with the correct values:

DOC/ROUGH
SPEED CONTROL
NORMAL CUTTING

If there is another (bigger) tool for this same PART MATERIAL, move your cursor to the next line down
and fill in these columns with the correct values:

TOOL MATERIAL
SIZE/WIDTH
DOC/ROUGH
SPEED CONTROL
NORMAL CUTTING
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This is a generic idea of what a chart might look like.

PART TOOL SIZE DOC NORMAL CUTTING

MAT'L MAT'L WIDTH ROUGH SFM F1 F2 F3 F4

PMAT-1 TMAT-1 SIZE 1 X

SIZE 2 X+

SIZE 3 X++

TMAT-2 SIZE 1 .075 Y SLOW-->-->--FAST

.095 Y+ SLOW-->-->--FAST

.115 Y++ SLOW-->-->--FAST

SIZE 2 .125 Z SLOW-->-->--FAST

.135 Z+ SLOW-->-->--FAST

.150 Z++ SLOW-->-->--FAST

SIZE 3 B SLOW-->-->--FAST

TMAT-3 SIZE 1 A

TMAT-4 SIZE 1 C SLOW-->-->--FAST

PMAT-2 TMAT-1 SIZE 1 D

SIZE 2 D+

TMAT-2 SIZE 1 .075 F SLOW-->-->--FAST

SIZE 2 .125 G SLOW-->-->--FAST

.135 G+ SLOW-->-->--FAST

.148 G++ SLOW-->-->--FAST

SIZE 3 J SLOW-->-->--FAST

TMAT-3 SIZE 1 K SLOW-->-->--FAST

To program a new PART MATERIAL, see CLING-ON or move your cursor to the next line down and fill
in these columns with the correct values for the new PART MATERIAL:

PART MATERIAL
TOOL MATERIAL
SIZE/WIDTH
DOC/ROUGH
SPEED CONTROL
NORMAL CUTTING

CLING-ON
How to use the same TOOL data with a different PART MATERIAL
Once you have input all the numbers for 316 Stainless, you may want to use them again for 304 Stainless.
Instead of typing all that information again for each insert material and size, you can just put one line at the
top of the FEED & SPEED Chart.  That line is called a CLING-ON.
You can cling-on to other materials that are programmed further down the chart.  Instead of IPR or SFM
values, you just put % values in the chart.
To duplicate (cling-on) exactly to another material, just put 100% in the SFM column and in the f1 through
f4 columns.

PART MATERIAL
Type in the name or abbreviated name of the NEW material.  This name must match exactly the PART
MATERIAL LIST.

TOOL MATERIAL
Type in the PART MATERIAL to be referenced.
Ex:  To have 304 use the values of 316, type 316 as the TOOL MATERIAL.  G-ZERO will then use the
modified values of 316 automatically.

SIZE/WIDTH
Skip this!

DOC/ROUGH
Skip this!

SPEED CONTROL
(SFM)
Type in the percentage of the
referenced material's surface feet/
minute.
Ex: To keep the same spindle
speed, put 100% in the SFM
column.  To double the spindle
speed, put 200%.

NORMAL CUTTING
Type in the percentage of the
referenced material's loads (f1,
f2, f3, f4) for roughing tools.
Ex:  To keep the same load ratio,
put 100% in each column.  To
double each load, put 200% in
each column.

LIVE MILL PLUNGE
Skip this!
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Viewport

The viewport is a window independent from the G-ZERO application window.  Its size, location and display
can be adjusted through a right-mouse-button list box and a toolbar.  (To display the right-mouse-button
list box, place your cursor in the Viewport and click the right mouse button.)
Note:  Press the F7 function key to hide or display the viewport from the G-ZERO application window.

System
Move - (Undocked) Your mouse cursor will change to a four-arrow icon  (cursor needs to be on
viewport), click and hold the left button of your mouse and drag the entire viewport to the location you
want.  This same action of dragging the viewport to a new location can be done by clicking the Move icon
from the toolbar.
Full Screen - (Undocked) Viewport will take up the entire screen of your monitor.  To go back to the
previous screen size, click the right button of your mouse, select System, and the option sizeable screen.
Show Editor - Hides the viewport and returns to the source code programming screen.  The same action
can be performed by pressing the F7 function key.
Dockable - If this option is selected, the viewport will be docked to the upper right corner of the source
code programming screen.  To undock the viewport, unselect the Dockable option from the System list.
Docking or undocking the viewport can also be done by clicking the Dockable icon from the toolbar.
Show ToolBar - Select this option to display toolbar at the top of the viewport.  To hide the toolbar,
unselect this option.
The toolbar can be detached from the viewport.  This is done by clicking on the gray area of the toolbar and
dragging it to another location.  To dock the toolbar to the viewport, drag the toolbar back to the top section
of the viewport.
Show Title - (Undocked) Select this option to display a title bar at the top of the viewport.  To hide the title
bar, unselect this option.  The title bar is also used to display the current Tool number during a simulation.
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Resize Viewport
Just like any Window, you can adjust the size of the viewport using your mouse.  Place your mouse
cursor on any edge or corner of the viewport to change the white arrow cursor to a double black arrow
pointed up and down  , or pointed left and right  , or pointed diagonally .  At this point, click and
hold the left button of your mouse and drag the edge (or edges if it’s a corner) of the window to increase
or reduce the size of the viewport.

Copy To ClipBoard
Once you click on this option, G-ZERO will automatically send the graphic currently displayed in the
viewport (without border and title bar) to the Windows Clipboard.  You can use another program (such as
Paint) to paste and print the image just captured.  (Note: For best results, set your computer color palette
greater than 256 colors)

Print View
Click on this option to send the graphic currently displayed in the viewport to your default printer.  Note that
printing with this option will include the black background.

Zoom
Zoom Previous - To zoom to the previous zoom window, select  from the Zoom options pull-down
menu on the toolbar.  The keyboard shortcut is Ctrl+P.
Zoom Out - Zooms out the current display; in other words, more (and smaller) graphic is displayed in the
same size viewport.  The keyboard shortcut is Ctrl+O.
Zoom In - Zooms in the current display; in other words, less (and larger) graphic is displayed in the same
size viewport.  The keyboard shortcut is Ctrl+I.
Zoom options NOT available through the right-mouse-button list box:

Zoom Window - Click (left button) and drag from one corner of the area you want to enlarge, to the
opposite corner.

Refresh - To restart simulation at the current zoom window, select  from the Zoom options pull-
down menu on the toolbar.  The keyboard shortcut is Ctrl+R.

Redraw
Part View   F2  - Redraws the entire source program without tool path.
Tool View   F3  - Redraws the entire source program and also shows the tool path.
Solid View   F6  - Starts the solid view simulation of the entire source program in the default solid view.
(See Solid Modeling / Simulator section).  Note:  Press the A key to stop simulation.
Single Step  - Redraws your entire source program one step at a time.  The source code programming
window highlights the line code it is simulating in the viewport.  Each time you click the left button of your
mouse (or press the space bar from your keyboard), the simulation advances one step (one line in the source
program).  Note:  Press the S key to exit the Single Step mode and finish the redraw in normal simulation
speed.  Similarly, press the S key while redrawing (wireframe or solid) to continue the simulation in single
step mode.
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SnapShot (with WinLauncher)
With a SnapShot (bitmap file), G-ZERO WinLauncher displays a graphic of the source file that is selected
from the Launch File dialog box.  In this way, you can see a graphical image of the source file selected
before you decide whether you really want to open it or not.
Note that your WinLauncher needs to be setup to use the “incremental search” method rather than the
traditional Windows 95, 98 search.  To do this, select the “Setup” hypertext from the WinLauncher main
menu, click on the “Options” tab, and select the “Incremental Search” method in the “File Dialog” section.

To take a SnapShot (Viewport of G-ZERO Lathe), select the SnapShot  option from the  pull-down
menu in the viewport Toolbar.  Once you click on this option, G-ZERO redraws your image in order to take
a good SnapShot and it creates a Bitmap file using the same source name and extension BMP.  This bitmap
file is placed in the same directory as your source file.  (Note: For best results, set your computer color
palette greater than 256 colors)
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Solid Verification 

Simulation
With solid modeling displayed on your viewport, you can watch a simulation of your machining while you
are programming.  Any time you press , G-ZERO will instruct the simulation program to start an ani-
mated representation of your entire source code.

         

Tool display
The tool can be shown in wireframe and shaded modes.
To set the mode, right-click on the viewport (picture area), and select Solid View Settings|Tool
Display.   Turbo mode may also be selected from this menu.  This mode hides the tool so the
finished part comes up in the shortest possible time.

Part Display
There are nine preset part orientations that can be set in the Part Display section of  Solid View Settings. 
Right click on the viewport (picture area) to change this setting.

         

        Iso 1                Iso 2      Iso 3           Iso 4

            

Top Bottom Left Right Front
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Input Math

We usually program our G-ZERO source codes entering values relative to the point of origin (0,0).  On the
other hand, most blueprints show dimensions in a different way, making it a little harder to get the values
you need for G-ZERO directly from your blueprint.  This is the reason why G-ZERO developers included
this input method through Math Calculation.
For example, if we want to mill the profile of the symmetrical part shown below, we need to know the
coordinates of 9 points (A through I).  Using point A as our point of origin (where X=0 and Y=0), our
source code will need the relative coordinates of the rest of the points (X and Y distance between point A
and the rest of the points).
Using the dimensions given in the graphic, we can calculate the relative coordinates of points B through I as
follow:

X Z

A 0 -.1

B .8/2 -.1

C .8/2 0

D 1/2 0

E 1/2 -.6

F 2/2 -.6

G 2/2 -1

H (2/2)-.1 -1

I (2/2)-.1 -1-.5

J 2/2 -1-.5

Operations and symbols
These are the symbols you can use when programming:

+ plus:  addition operation

- minus:  subtraction operation

* asterisk:  multiplication operation

/ forward slash:  division operation
\ back slash:  integer division operation
^ caret:  exponential (power) operation
( open parenthesis:  symbol used to indicate the start of a group

) close parenthesis:  symbol used to indicate the end of a group
= equal:  symbol used to display the result of the calculation before entering the value with the Enter

key
@ at:  symbol used to make the default value available as the first number in the calculation.  Example:

if you just drilled a hole at x=1.23 and you now want to drill a hole that is over .5506 from the last
hole, then enter @+.5506   (The key “@” saves you from typing “1.23” in the calculation)
right arrow:  0º
up arrow:  90º
left arrow:  180º
down arrow:  270º

‘ apostrophe:  converts degrees in dd.mmss format to decimals.  Example: if you need to enter
35º10’30” in decimal degrees, type 35.1030’ and G-ZERO will make the conversion: 35.175

“ quote:  converts degrees in dd.mmss format to decimal degrees. (Same as apostrophe symbol)

2.0"

2.5"

0.6"

1.0"

0.1"

1.0"0.8"

0.5"

B C
D

A

E

FG
HI

J

Z

X

0.1"



26      REFERENCE Basics

Hierarchy
G-ZERO uses the same symbol hierarchy used in Algebra:

1st priority: ( )     G-ZERO allows unlimited number of nested parenthesis

2nd priority: *  / \
3rd priority: + -

Examples:
5.4-1.88/2 = 5.4-0.94 = 4.46

5.4-(1.88/2) = 5.4-0.94 = 4.46

(5.4-1.88)/2 = 3.52/2 = 1.76

2+3^2-5/2 = 2+(3^2)-(5/2) = 2+9-2.5 = 8.5

9\2 = INT(9/2) = 4

Mainwin Calculator (Triangle)
G-ZERO comes with a calculator to assist you calculate unknowns in triangles, as well as trigonometry and
basic algebra.  To open the Mainwin Calculator, select  Triangle from the Tools pull-down menu, or use
the keyboard shortcut Ctrl+T.

Triangle functions
Mainwin Calculator offers seven situations for you to calculate
unknown values in triangles:

2 sides known
1 side, 1 angle known
3 sides known
adjacent side-side-angle known
adjacent side-angle-side known
adjacent angle-side-angle known
adjacent angle-angle-side known

Just enter 2 or 3 values of a triangle (sides or angles), and the calculator will give you the values for the rest
of the sides and/or angles.  You can use the drag-and-drop method to select any one of these results and
drop it on the dialog bar of G-ZERO application window and use it as the answer to your programming
question.

Math functions
Functions available are: ABS, SIN, COS, TAN, ATAN, LOG,
SQRT, INT, FRAC, CIEL, FLOOR, LOG10, EXP.
Use the bottom Edit bar to type your Math function.  After you
press the Enter key, the result will appear in the same Edit bar.
Use the drag-and-drop method to select the result and drop it on
the dialog bar of G-ZERO application window to use it as the
answer to your programming question.
Math functions need to be typed in upper case; they work in
radians and the results are also given in radians (not decimal).
Use Math functions in  Mainwin Calculator only; do not use them directly in the dialog bar of G-ZERO
application window.

Math operators
Operators available are: + plus > greater

- minus < smaller
* multiply <> not equal
/ divide & and
\ integer divide | or

Results of all math calculations can be dragged and dropped into the dialog bar of G-ZERO application
window to use it as the answer to your programming question.
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Special Keys

Positioning
Page Up ..............Up one screen
Page Down .........Down one screen
Up Arrow ...........Up one line
Down Arrow .......Down one line
Home ..................To beginning of source program
End .....................To end of source program
Ctrl+L .................Goto a specific line (key in line number)
Ctrl+F .................Find
Ctrl+S .................Find next

Programming
Esc ......................Undo last source line.  Undo last value entered if programming a command
O ......................... (Letter O).  Override:  forces G-ZERO to accept values out of normal range
Any Letter(s) ......Comment
% ........................Machine readable comment or post command (key in ONLY machine readable comments

after the % symbol to avoid an alarm on your machine).  See %Command section.
# .........................Calls data or program from another file
F1 or ? ................Help on command currently programming.  Main Help menu if you are not in the middle

of programming a command

Tools
Ctrl+T.................Mainwin calculator (Triangle)
F1 .......................Help
F8 .......................Sketch/Machine (Option)
F9 .......................CAD Reader
F11 .....................Mouse Rough
F12 .....................Post Process

Viewport
F2 .......................Part view
F3 .......................Tool view
F6 .......................Solid view
F7 .......................Show/Hide viewport
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% Commands

% ........................Machine readable comment or post command (key in ONLY machine readable comments
after the % symbol to avoid an alarm on your machine).

%+ ......................Continue comment from previous line, or add G-code to line above.

General
%( comment ) .....Send man-readable comment to machine.  Example:  %(CARBIDE ENDMILL)
%O .....................Set program number (place before the first Tool).  Example:  %O0234  sets program

number to be “0234”
%N_ S_ ..............Output whole line without processing.  Example:  %N25 S20  (CNC sees this, G-ZERO

does not).
%OFF .................Following source lines are for definition only.
%ON ..................Cancels %OFF.
%C......................Sets C-axis when Y-axis is active (livetool mode only)

Tool change
Note:  %Anything  can be programmed in the TOOL *** comment area.
%M0 ...................Set var #56 in UNIM.
%S0 ....................Set var #55 in UNIM.

Feedrate
%F ......................Override G-ZERO automatic feedrate selection from that point in the source program to

the next tool change.  Example:  %F.002 sets the feed at .002 inches per revolution.
%F99.99  unlocks a feed and lets G-ZERO start its automatic feedrate selection again.

Special Words

Some words entered as Comments perform specific functions.  These reserved words are:

COLOR
Type the word COLOR followed by a number to change the color of your graphics from the current line
until the the next Tool or COLOR comment.  This is quite helpful when a tool will be used for several
different layers of your part.
Example:  COLOR 1  will draw in blue.

0 Black 4 Red 8 Gray 12 Light Red
1 Blue 5 Magenta 9 Lilght Blue 13 Light Magenta
2 Green 6 Brown 10 Light Green 14 Yellow
3 Cyan 7 White 11 Light Cyan 15 Hi-intensity White
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Spindle speed
%S ......................Override G-ZERO automatic spindle speed selection.  Example:  %S2500 sets the spindle

at 2500 rounds per minute.
%SMAX .............Set maximum allowable rpm for all tools.  Program before first tool.  Example:

%SMAX1200  limits spindle to 1200 rpm.
%s300 .................Example: %s300 uses 300 surface feet per minute.

Coolant
%COOL OFF .....Turn coolant off.
%COOL ON .......Turn coolant back on again.
%COOLIN .........Set coolin flag: var #26 in UNIL.

Post
%#POST ............Resets .P file variables.  Example 1:  %#POST(21)=1  turns on metric.

Example 2:  %#POST(52)=1  turns on tracing.
%#ARG ..............Reset post global variables.  Example:  %$ARG(101)=HI MOM  resets tool comment

string.

Blockskip
%BS ...................Turns on blockskip “/” mode.  (Also works in the *** comment section of the tool

command)
%BS1 thru %BS9 ..Generates “/1” thru “/9” for machines with multiple levels.
%BS OFF ...........Turns off blockskip mode.

112999 lathe4-ref-basic.p65
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